Isometric Drawing

Sacramento City College
Engineering Design Technology
Drawing Types

- Pictorial Drawing types:
  - Perspective
  - Orthographic
  - Isometric
  - Oblique
- Pictorial - like a picture
Pictorial Drawing

- Pictorial drawing is
  - part of graphic language.
- Used in
  - Engineering
  - Architecture
  - Science
  - Electronics
  - Technical illustration, and
  - Other professions.
Examples of pictorial drawing use:

**Architects**
- Use pictorial drawing to show what a finished building will look like.

**Ad agencies**
- Use pictorial drawing to display new products.
Pictorial Drawing
Pictorial Drawing

- Pictorial drawing is often used in exploded drawings on production and assembly drawings.
  - Refer to Figure 12-1
Pictorial Drawing

- **Views** are made to illustrate the operation of machines, and equipment.

- Pictorial sketches are used to help convey ideas that are hard to describe in words.
Pictorial Drawing

- Space Shuttle Orbiter

- Length: 122 ft.
- Wingspan: 78 ft.
- Weight: 190,000 lbs.
- Height: 57 ft.

- Star Tracker Panel
- Payload Bay 40 ft.
- Orbital Propulsion
- Aft Reaction Control Engines
- Main Engines (3)
- Body Flap
- Launch Umbilical Panel
- Elevons
- Side Hatch
- Forward Engines
- Nose Landing Gear
- Umbilical Panel
- Rudder/Speed Brake
RIGHT HAND ILLUSTRATION
Parts are numbered in order of disassembly.
Pictorial Drawing

- Pictorial drawing can be
  - Perspective Views
    - Show object as it actually looks to the eye.
  - Isometric Views
    - Easier to draw than perspective.
    - Do not look as good as perspective.
  - Oblique Views
    - Easier to draw than perspective.
    - Do not look as good as perspective.
Isometric Drawing
Isometric Drawing

- Pictorial drawings, in general, are made to show how something looks.

- Since hidden lines are “not part of the picture” they are normally left out and are not drawn in isometric drawings.
Isometric Drawing

- Isometric drawing is
  - Similar to isometric sketching except that it is created using instruments.
Isometric Drawing

- Objects are aligned with three *isometric* axes at 120° angles to each other.
- Refer to Figure 12.4.
Figure 12-3

TWO-POINT PERSPECTIVE

ISOMETRIC
Figure 12-3

ONE-POINT PERSPECTIVE

OBLIQUE CABINET

OBLIQUE CAVALIER
Isometric Drawing

- X, Y and Z axes
  - Can be positioned in several arrangements
  - Must remain at 120 degrees to each other.
Isometric Drawing

- **Vertical Orientation - Regular Position**
  - **First position** - the axes meet at the upper front corner of the object
  - **Second position** - the axes meet at the lower front corner of the object.
Figure 12-4

VERTICAL

FIRST POSITION  SECOND POSITION

REGULAR
Figure 12-4

FIRST POSITION  SECOND POSITION

REVERSED

HORIZONTAL

Isometric Drawing
Isometric Drawing

- Horizontal Orientation - Regular Position
  - First position - the axes meet at the left front corner of the object
  - Second position - the axes meet at the right front corner of the object.
Figure 12-4

FIRST POSITION

SECOND POSITION

REGULAR
Figure 12-4

FIRST POSITION

SECOND POSITION

REVERSED
Isometric Lines
Isometric Lines

- Any line parallel to one of the isometric axes is called an isometric line.
Non-isometric Lines
Non-isometric Lines

- Lines that are not parallel to one of the axes are called **non-isometric lines**.
Non-isometric Lines

- Measurements can be made only on isometric lines.

- Non-isometric lines do not show in their true length so they cannot be measured.
Non-isometric Lines
Non-isometric Lines
Drawing Non-Isometric Lines

- To draw non-isometric lines:
  - Locate the end points first.
  - Use the Box Method.
- Refer to Figure 12-6.
Drawing Non-Isometric Lines
Drawing Angles

- Follow the procedure shown in Figure 12-7
  - Construct angle parts AO, AB, OB
  - Transfer AO and AB to the isometric cube
  - Lay off AO on the base of the cube
  - Draw AB parallel to the vertical axis
  - Finally, connect points O and B to complete the isometric angle
Drawing Angles
Isometric Circles
Isometric Circles

- In isometric drawings, circles appear as ellipses.
Use the four centered approximation method to draw the ellipse.
Refer to Figure 12-9.
First, draw an isometric square, with the sides equal to the diameter of the circle.

Draw an isometric square with the sides equal to the diameter of the circle.
Use a 30° 60° triangle to locate points A, B, C, D and points 1, 2, 3, 4.
Drawing Isometric Circles

- Use A and B as centers, and radius = A2, draw the arcs

With A and B as centers and a radius equal to A2, draw arcs as shown.
Drawing Isometric Circles

- Use C and C as centers, radius = C4, draw arcs to complete the ellipse

With C and D as centers and a radius equal to C4, draw arcs to complete the isometric circle (ellipse).
Isometric Cylinder

To draw an isometric cylinder

- Use Figure 12-9 to construct the top ellipse.
- Drop centers at a distance equal to the height of the cylinder.
- Draw three arcs using the same radii as the ellipse at the top.
- Notice that the radii for the arcs at the bottom match those at the top.
Isometric Cylinder
To draw quarter rounds

- Refer to Figure 12-12.
- Follow procedure for quarters of circles.
- In each case measure the radii along the tangent lines from the corner.
- Then draw the perpendiculars to locate the centers for the isometric arcs.

Figure 12-13 shows how to draw outside and inside corner arcs.
Isometric Drawing

Isometric Quarter Rounds

\[ R_1 = R_2 = R \]

\[ = \text{RIGHT ANGLE (90°)} \]
Isometric Templates
Isometric Templates

- Isometric templates come in a variety of forms
  - $15^\circ$, $30^\circ$, $45^\circ$, $50^\circ$, $60^\circ$
  - They are convenient and can save you time.
Creating an Isometric Drawing
Creating an Isometric Drawing

- Filler Block Example
- Refer to Figure 12-17.

Fig. 12-17 Steps in making an isometric drawing.
Creating an Isometric Drawing

- Filler Block Example
  - Draw the isometric axes in the first position.
Creating an Isometric Drawing

- Filler Block Example
  - Measure off the width, the depth and the height of the block on the three axes.
Creating an Isometric Drawing

- Filler Block Example
  - Draw lines parallel to axes to make the isometric drawing of the block.
Creating an Isometric Drawing

- Filler Block Example

**Fig. 12-17** Steps in making an isometric drawing.
**Reversed Axes**

- To draw an object as if viewed from below, reverse the position of the axes.
  - Follow example in Figure 12-20.
Reversed Axes
Creating an Isometric Drawing

- When long pieces are drawn in isometric, make the long axis horizontal.
- Refer to Figure 12-21
Dimensioning Isometric Drawings
Isometrics are seldom used as working drawings.

Remember, working drawings are the drawings used to actually construct the object.

If dimensions are required, follow the newer unidirectional format.

Refer to Figure 12-22.
Dimensioning Isometrics
Isometrics – Multiple Scales
Isometrics-Multiple Scales

- **Isometric**
  - Only one scale is used

- **Dimetric**
  - Two scales are used.

- **Trimetric**
  - Three scales are used.
Isometrics-Multiple Scales

Isometric Drawing
Oblique Drawings
Oblique Drawings

- **Oblique drawings are**
  - Similar to isometric drawings,
  - Are drawn on three axes (X, Y, Z).
  - **Two axes are parallel to the picture plane** (the plane on which the view is drawn).
  - These two axes always are at **right angles**.
  - Think “Front View with depth”.
In isometric drawings, only one axis is parallel to the picture plane.

Refer to Figure 12-28.
Oblique Drawings

- Oblique drawings show an object as if viewed face on.
- The object is seen squarely with no distortion.
Oblique Drawing Rules

To create an oblique drawing:

- Draw a front view, long side horizontal
- Draw the depth
- Refer to Figure 12-29.
Oblique Drawing Rules

Fig. 12-29  Two general rules for oblique drawings.
Oblique Projection

- Oblique projection is a way of **showing depth**.

- Depth is shown by **projector lines**.

- **Projector lines** represent receding edges of an object.
  - These lines are drawn at an angle other than 90° from the picture plane so they will be visible in the front view.
Oblique Projection

- Lines on these receding planes that are parallel to each other are drawn parallel.

- Refer to Figure 12-30.
Oblique Projection

- Because oblique drawing can show one face of an object without distortion it has a distinct advantage over isometric.

- Oblique drawings are useful for showing objects with irregular outlines.
Oblique Drawing Types

- **Cavalier Oblique**
  - receding lines are drawn **full length**.

- **Normal Oblique**.
  - receding lines are drawn **3/4 length**.

- **Cabinet Oblique**.
  - receding lines are drawn **1/2 length**
  - named this way because it is often used in the furniture industry

- Refer to Figure 12-32
Oblique Drawing Types

MULTIVIEW

CAVALIER

NORMAL

CABINET

Isometric Drawing
**Oblique Constructions**

- **Angles and Inclined Surfaces**
  - Angles that are **parallel to the picture plane** are shown full size.
  - For all other angles, lay the angle off by locating both ends of the slanting line.
  - Remember to lay off angles by measurements parallel to one of the axes.
Oblique Constructions

- **Oblique Circles**
  - Use the four-center method for ellipses.
  - Ellipse *templates* give better results.
  - If you use a template, block the oblique circle as an oblique square.
Oblique Drawings

- Types of Oblique drawings:
  - Cavalier.
  - Cabinet.
  - General or Normal.

- They vary by the depth of the receding axis.

- Usually drawn at 45° for the Z axis.
Isometric Types

Cavalier

Cabinet

General
Isometric Types

CAVALIER

NORMAL

CABINET
Isometric Drawings

- Are more realistic than oblique drawings
- The object appears as if tilted toward the viewer.
- Isometric means "equal measure".
- The equal measure refers to the angle between the three axes (120°)
- See Figure 26-2
Figure 26.2
Isometric Drawings

- All three axes can be measured using the same scale.
- Dimetric uses two scales.
- Trimetric uses three scales.

See Figure 26-3.
Isometric Drawings

Isometric: 1 1 1
Dimetric: .92 .54
Trimetric: .90 .80
Perspective Drawings

- Perspective drawing is the most realistic.

- Types of perspective drawings:
  - One point.
  - Two point.
    - Often used in architecture
Perspective Drawing Definitions

- Refer to Figure 12-40
  - Sight lines which lead from the points on the card and converge at the eye are called **visual rays**.
  - The **picture plane** is the plane on which the card is drawn.
  - The **station plane** is the point from which the observer is looking at the card.
  - A horizontal plane passes through the observer’s eye. Where it meets the picture plane, it forms the **horizon line**.
**Perspective Drawing Definitions**

- Where the ground plane on which the observer stands meets the picture plane, it forms the ground line.
- The center of vision is the point at which the line of sight pierces the picture plane.
- The line of sight is the visual ray from the eye perpendicular to the picture plane.
- The point at which the receding axes meet (the projectors) is called the vanishing point.
Fig. 12-40 Some perspective terms.
Perspective Drawing Definitions

- If the object is seen from above, the view is **aerial** or **bird’s eye view**
- If the object is seen from below, the view is **ground** or **worm’s eye view**
- If the object is seen so that the line of sight is directly on it, the view is a **normal view**
Fig. 12-50 Multiview and isometric drawings of an object to be drawn in two-point perspective.
Factors That Affect Appearance

◆ In perspective drawing, the size of the object seems to change as you move toward or away from it.
  ◆ Refer to Figure 12-42 for explanation
  ◆ Each time the distance from the object is doubled, the object appears only half as large
Factors That Affect Appearance

- The shape of the object seems to change when viewed from a different position
  - Looking at a square directly, the edges are parallel.
  - Looking at it from an angle, the edges seem to converge
One Point Perspective

- **One-point perspective**, has one vanishing point, and is also called parallel perspective.

- **Two point** perspective drawings have two vanishing points, also called angular perspective.
Fig. 12-42  The size of an object appears half as large when the distance from the observer is doubled.
One Point Perspective
Two Point Perspective
Isometric Drawings

- **Isometrics** are the most common type of pictorial drawing.
  - Single view showing three sides.
  - All three sides are the same scale.
**Isometric Drawings**

- **Lines parallel to the axis** $x$, $y$ or $z$
  - Can be measured and
  - Is called an *isometric line*.

- **Lines not parallel to the axes** $x$, $y$ or $z$
  - Cannot be measured and
  - Are called *non-isometric lines*. 
Isometric Drawings

- Circular features must be oriented properly or they will appear distorted.
- Circles appear as ellipses.
- Refer to Figure 26-6.
Circles Appear As Ellipses
Screen crosshairs
Isometric Drawings

- The **Minor Axis** must always align on the axis of the circular feature.

- Remember: **lines parallel** in an **orthogonal view**, must be **parallel** in the **isometric view**.
Setting Isometric Variables
To activate the Isometric Grid:

1. Access the Drawing Aids dialog box:
   - Type `DDRMODES` or `RM` at the Command: prompt.
   - Select **Drawing Aids** from the **Tools** pull-down menu.
To activate the Isometric Grid:

2. Choose “Tools” “Options” from the pull-down menu.
Isometric Drawing

Drafting Settings...
Activating the Isometric Grid

- To activate the Isometric Grid:
  - 3. Use the SNAP command.
    - Set the Style to Isometric.
    - Set the vertical spacing.

- The grid changes to isometric
- The cursor changes to isometric.
Changing Crosshairs Orientation

- AutoCAD refers to isometric positions as Isoplanes.
- Changes the cursor orientation from:
  - LEFT
  - TOP
  - RIGHT

- Press the F5 key or [Ctrl-E] key to change cursor to the next plane orientation.
Isometric Drawing

110

Left
ISOPLANE Command

- The ISOPLANE command is transparent.
- It can be changed to another orientation while inside another command.
- Just hit the “F5” key.
Isometric Circles
Isometric Ellipses

- Draw isometric ellipses (circles) by:
  - Picking the Ellipse button on the Draw toolbar.
  - Typing EL or ELLIPSE at the Command prompt.
Isometric Ellipses

- Select **Axis**, **End** from the **Ellipse** cascading menu in the **Draw pull-down menu**.

- Select Isocircle suboption
  - Pick the center point
  - Pick the diameter

- *Don’t pick the Center option!*
  - It doesn’t allow you to create isometric circles.
Isometric Ellipses

Three options to create ellipses.

#1
- When DRAGMODE is on, the ellipse changes size as the cursor moves.
- Set the radius by picking a point.

#2
- Enter a numeric value and press [Enter]

#3
- Type D, and enter the circle diameter.
Isometric Ellipses

- Always check the isoplane position first.
- The isometric ellipse is a true ellipse.
  - If selected, grips are displayed at the center and four quadrant points making editing easy.
Drawing an isometric circle using “ISOCIRCLE”

TOP VIEW
Drawing an isometric circle using “ISOCIRCLE”

RIGHT SIDE VIEW
Drawing an isometric circle using "ISOCIRCLE"

LEFT SIDE VIEW
Isometric Ellipses

- Don’t use grips to edit an isometric ellipse (!)

- As soon as you resize an isometric ellipse in this manner, its angular value is changed, and it is no longer isometric.

- Rotate ellipses only by using an angle of $120^\circ$
An “Edited” Isocircle
Constructing Isometric Arcs

- Construct Isometric Arcs by:
  - The Arc option of the ELLIPSE command
  - Pick Arc from the Ellipse cascading menu in the Draw pull-down menu
Constructing Isometric Arcs

- Isometric arcs are **fillets** and **rounds**.

- **Procedure – fillets and rounds**
  - 1. Draw the object first and then **trim the excess** after drawing the fillet.
  - 2. The **center point** is the critical feature.
  - 3. The center point should be located first.

- Refer to Figure 26-13.
Figure 26-13.
Rounds can be drawn with the Arc option of the ELLIPSE command.
Drawing the Rounds

- To draw rounds
  - Draw the box outline first.
  - Determine the center point of the arc FIRST!
  - Command: ELLIPSE
  - ARC
  - ISOCIRCLE
  - Specify radius of isocircle
  - Specify start and end points of round.
Copy round to here.

Center Point of Round
Isometric Dimensioning
Creating Isometric Text Styles

- Isometric dimensions can be “approximated” by AutoCAD.

- Isometric text should appear to lie in one of the isometric planes.

  - Use an obliquing angle of $30^\circ$ or $-30^\circ$.
  - The rotation angle is entered when using one of the TEXT commands.
  - This technique can be applied to any font.
Figure 26-14
this is iso right
text obliqued (30) and
rotated (30).
Notice how the start point of the
text continues to
move to the right.

this is iso left
obliqued (-30) and
rotated (-30).
Notice how the text continues to
move to the left.

Enter text: of the text continues to
Enter text: move to the right.*Cancel*
Specify rotation angle of text <330>: 4.9796 5.3750 0.0000
This is a created style

"Iso Top"

dthis is text at a 30 degree angle

and a (-30 degree) obliquing angle

Notice how the start point of the
text continues to move to the left.

hand: _saveas

hand:

25, 3.5213, 8.0000

SNAP|GRID|ORTHO|POLAR|OSNAP|STRETCH|LWT|MODEL
Extension lines should always extend in the plane being dimensioned.
The heel of the arrowhead should always be parallel to the extension line.

Figure 26-18
The strokes of the text should always be parallel with the extension lines or dimension lines.
Oblique Dimensioning
Oblique Dimensioning

- AutoCAD can semi-automatically dimension isometric and oblique lines.

- Draw dimensions using any of the linear dimensioning commands.
  - Usually “DAL”

- Refer to Figure 26-18A.
Oblique Dimensioning

- Use the **Oblique** option of the **DIMEDIT** command to **rotate** the extension lines into a plane parallel with the isometric axes.

- Refer to Figure 26-18B.
Oblique Dimensioning

To access the Oblique option:
- Type `DIMEDIT` at the Command: prompt
- Enter `O` (oblique)
  - OR
- Select **Oblique** from the Dimension pull-down menu.
  - Select the dimension and
  - Enter the obliquing angle.

Refer to Figure 26-18.
Dimension created with DAL. Dimension is NOT "Obliqued".
Dimension created with DAL.
Dimension is "Obliqued" 30 degrees.
Obliqued 30 degrees

Obliqued -30 degrees
Isometric Dimensioning Procedure

1. Create isometric arrowheads
2. Create text styles.
3. Manually draw the dimension lines and text as they should appear in each of the three isometric planes.
   - This is time consuming compared to 2D dimensioning.
4. Refer to Figure 26-15.
Isometric Dimensioning

- Refer to Figures 26-16, 26-17.
  - Arrowheads can be drawn with the PLINE or LINE commands.
  - **Draw one arrowhead** and **MIRROR** it to create the “opposite one”.
  - **Save each arrowhead as a block** in your isometric template or prototype.
Dimension Arrowheads

[Diagram showing different types of dimension arrowheads for top, left, and right views]
Dimension Arrowheads
Figure 26-18

Isometric Drawing
Assignments
Problems 26-1 and 26-2

1. [Diagram of a geometric shape]

2. [Diagram of a geometric shape]
Problems 26-3 and 26-4

3.

4.
Problems 26-5 and 26-6

5.

6.
Problem 21-4